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 Important Information

Warranty
The FieldPoint hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor. 
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.
A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.
National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.
EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.
Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.
(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
the product, refer to the Read Me First: Safety and Radio-Frequency 
Interference document, shipped with the product, for precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names and LED names.

cFP-21xx cFP-21xx refers to the cFP-2100, cFP-2110, and cFP-2120.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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1
Overview of Compact FieldPoint

This chapter provides an overview of the cFP-21xx Compact FieldPoint 
controller and FieldPoint software.

cFP-21xx Compact FieldPoint Controller Overview
Using the cFP-21xx controller with LabVIEW Real-Time provides an 
easy-to-use system for real-time embedded applications. When you run the 
LabVIEW Real-Time Engine on a cFP-21xx, the controller can run 
applications without a host PC. If you connect the cFP-21xx to an Ethernet 
network, you can use a separate host PC running Windows to display 
measurement results and status information and change the settings of the 
controller. Refer to the LabVIEW Help for more information about the 
LabVIEW Real-Time Engine.

Besides the Ethernet port, the cFP-21xx has one or more RS-232 serial 
ports accessible through software. It also has LED indicators to 
communicate status information and DIP switches that perform various 
functions. The cFP-2120 also has a software-accessible RS-485 port and 
switch input/LED output for connecting to external devices such as LED 
status indicators and start/stop buttons. Figure 1-1 shows where all of these 
features are located on the cFP-21xx. The figure indicates which features 
are available only on specific models such as the cFP-2120.
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Figure 1-1.  cFP-21xx Parts Locator Diagram

A Compact FieldPoint system consists of one cFP-BP-x backplane, one 
cFP-21xx controller, one or more I/O modules, and one or more connector 
blocks or accessories. Each Compact FieldPoint system can be accessed by 
an unlimited number of PCs and controllers, forming a distributed 
computing system. The maximum number of cFP-21xx controllers that you 
can install on an Ethernet network is limited only by network topology.

The cFP-21xx controller connects directly to a 10 or 100 Mbps Ethernet 
network. The cFP-21xx auto-detects the speed of the connection 
and configures itself accordingly.

1 Ethernet Port
2 RS-232 Serial Port
3 Removable Compact Flash (cFP-2120 Only)
4 LED Indicators
5 DIP Switches
6 Reset Switch

7 Power Connector
8 Switch Input/LED Output Terminals (cFP-2120 Only)
9 RS-485 Serial Port (cFP-2120 Only)
10 RS-232 Serial Port (cFP-2120 Only)
11 RS-232 Serial Port (cFP-2110 and cFP-2120)
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For detailed hardware specifications and cabling information, refer to 
Appendix B, Specifications.

FieldPoint Software Overview
FieldPoint software includes NI Measurement & Automation Explorer 
(MAX) as well as server and driver software for easy integration into 
application software packages. These software components manage 
the low-level communications and hardware details, simplifying 
programmatic access to I/O channels. FieldPoint software runs on 
Windows 2000/NT 4.0 Service Pack 6+/XP and includes the following 
components:

• MAX

• LabVIEW VIs
• LabWindows™/CVI™ Functions

• Measurement Studio instrument drivers

• OPC Server
• VI Logger support

You can download a current version of FieldPoint software from the 
National Instruments Web site. Using your Web browser, go to ni.com, 
select Support»Drivers and Updates»Current Software Versions»
Distributed I/O—FieldPoint, then select the latest version of 
NI-FieldPoint.

cFP-21xx Setup Overview
The following list is an overview of the steps required to get started with 
the cFP-21xx and LabVIEW Real-Time.
1. Install hardware as described in Chapter 2, Installing Compact 

FieldPoint Hardware and Software.

a. Mount backplane on a panel, DIN rail, or standard 19-in. rack.

b. Mount cFP-21xx and I/O modules on backplane.
c. Connect cFP-21xx to network.
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2. Install software as described in Chapter 2, Installing Compact 
FieldPoint Hardware and Software.

a. Install programming software (LabVIEW Real-Time).
b. Install FieldPoint software.

3. Configure Compact FieldPoint system and verify configuration as 
described in the Measurement & Automation Explorer Help for 
FieldPoint.

a. Configure cFP-21xx network settings.
b. Configure I/O module ranges and settings.

c. Configure security.

d. Connect input signals and loads to I/O modules.
e. Test channels.

f. Save settings.

4. Configure optional settings as described in Chapter 3, Feature 
Descriptions.

5. Develop application as described in Chapter 4, LabVIEW Real-Time 
Programming.

a. Launch LabVIEW Real-Time.

b. Build basic application.
c. Switch execution target to test application on cFP-21xx.

d. Embed application by building .exe with LabVIEW Real-Time 
targeted to cFP-21xx.

e. Test embedded application.
6. Deploy system.
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2
Installing Compact FieldPoint 
Hardware and Software

This chapter explains how to install the Compact FieldPoint hardware and 
software.

What You Need to Get Started
To set up and use LabVIEW Real-Time with the cFP-21xx, you need the 
following:

� cFP-21xx Compact FieldPoint controller

� cFP-BP-x backplane

� Mounting hardware (DIN rail, panel-mount, or rack-mount accessory)

� cFP I/O module(s)

� Wiring accessories such as cFP-CB-x connector block(s) or cables

� 11–30 VDC power supply (20 W recommended)

� Ethernet cable

� 1/8 in. flathead and number 2 Phillips screwdrivers

� NI-FieldPoint software version 4.1.1

� A host PC running Windows 2000/NT 4.01/XP

� LabVIEW Real-Time software

1   Using FieldPoint software with Windows NT 4.0 requires Service Pack 6 or later.
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� Optional accessories

– 37-pin I/O cables
– Serial cables

– DIN-rail terminal blocks

Compact FieldPoint Safety Information
The following section contains important safety information that you must 
follow when installing and using Compact FieldPoint products.

Do not operate the Compact FieldPoint product in a manner not specified 
in the user manual or operating instructions. Misuse of the product can 
result in a hazard. You can compromise the safety protection built into the 
product if the product is damaged in any way. If the product is damaged, 
return it to National Instruments for repair. 

Do not substitute parts or modify the Compact FieldPoint product. Use the 
product only with the modules, accessories, and cables specified in the 
installation instructions. 

You must connect the protective earth (PE) ground terminal on the 
cFP-BP-x backplane to the system safety ground. The backplane PE ground 
terminal has the following symbol stamped beside it: . Connect the 
backplane PE ground terminal to the system safety ground using 14 AWG 
(1.6 mm) wire with a ring lug. Use the 5/16 in. panhead screw shipped with 
the backplane to secure the ring lug to the backplane PE ground terminal.

Do not operate Compact FieldPoint products in an explosive atmosphere or 
where there may be flammable gases or fumes. If you need to operate 
Compact FieldPoint products in such an environment, the Compact 
FieldPoint products must be in a suitably rated enclosure. 

If you need to clean a Compact FieldPoint product, use a soft nonmetallic 
brush. The product must be completely dry and free from contaminants 
before you return it to service.

Operate the product only at or below Pollution Degree 2. Pollution is 
foreign matter in a solid, liquid, or gaseous state that can reduce dielectric 
strength or surface resistivity. The following is a description of pollution 
degrees:
• Pollution Degree 1 means no pollution or only dry, nonconductive 

pollution occurs. The pollution has no influence.
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• Pollution Degree 2 means that only nonconductive pollution occurs in 
most cases. Occasionally, however, a temporary conductivity caused 
by condensation must be expected.

• Pollution Degree 3 means that conductive pollution occurs, or dry, 
nonconductive pollution occurs which becomes conductive due to 
condensation. 

Caution You must insulate signal connections for the maximum voltage for which the 
Compact FieldPoint product is rated. Do not exceed the maximum ratings for the product. 
Do not install wiring while the product is live with electrical signals. Do not remove or add 
connector blocks when power is connected to the Compact FieldPoint system. Avoid 
contact between your body and the connector block signal wiring when hot-swapping 
modules.

Operate Compact FieldPoint products at or below the installation category1 
marked on the hardware label. Measurement circuits are subjected to 
working voltages2 and transient stresses (overvoltage) from the circuit 
to which they are connected during measurement or test. Installation 
categories establish standard impulse withstand voltage levels that 
commonly occur in electrical distribution systems. The following is a 
description of installation categories:

• Installation Category I is for measurements performed on circuits not 
directly connected to the electrical distribution system referred to as 
MAINS3 voltage. This category is for measurements of voltages from 
specially protected secondary circuits. Such voltage measurements 
include signal levels, special equipment, limited-energy parts of 
equipment, circuits powered by regulated low-voltage sources, and 
electronics.

• Installation Category II is for measurements performed on circuits 
directly connected to the electrical distribution system. This category 
refers to local-level electrical distribution, such as that provided by a 
standard wall outlet (for example, 115 V for U.S. or 230 V for Europe). 
Examples of Installation Category II are measurements performed on 
household appliances, portable tools, and similar products.

• Installation Category III is for measurements performed in the building 
installation at the distribution level. This category refers to 
measurements on hard-wired equipment such as equipment in fixed 

1   Installation categories, also referred to as measurement categories, are defined in electrical safety standard IEC 61010-1.
2   Working voltage is the highest rms value of an AC or DC voltage that can occur across any particular insulation.
3   MAINS is defined as a hazardous live electrical supply system that powers equipment. Suitably rated measuring circuits may 

be connected to the MAINS for measuring purposes.
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installations, distribution boards, and circuit breakers. Other examples 
are wiring, including cables, bus-bars, junction boxes, switches, 
socket-outlets in the fixed installation, and stationary motors with 
permanent connections to fixed installations.

• Installation Category IV is for measurements performed at the primary 
electrical supply installation (<1,000 V). Examples include electricity 
meters and measurements on primary overcurrent protection devices 
and on ripple control units.

Mounting the Compact FieldPoint Backplane
You can mount the cFP-BP-x backplane on a panel or in a standard 19 in. 
rack. You can mount the cFP-BP-4 on a 35 mm DIN rail. The following 
sections contain instructions for all three mounting methods. Before using 
any of these mounting methods, record the serial number from the back of 
the backplane. You will be unable to read the serial number after you have 
mounted the backplane.

To ensure maximum cooling efficiency, mount the Compact FieldPoint 
system so that the I/O module vents are at the top and bottom.

Figure 2-1.  cFP-BP-4 Backplane Properly Mounted

Caution As you mount the backplane, keep in mind the following requirements for space 
and cabling clearance:

• Allow 51–76 mm (2–3 in.) all around the backplane for air circulation.
• Allow 76 mm (3 in.) in front of the controller and 38 mm (1.5 in.) below the controller 

for cabling clearance.

Up
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Figure 2-2.  cFP-BP-x Backplane with cFP-21xx Installed,
Bottom View with Dimensions

Figure 2-3.  cFP-BP-x Backplane with cFP-21xx Installed, Front View with Dimensions
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Caution NI recommends that you use one of the mounting systems described in this 
document. If you decide to use a custom mounting solution, make sure that the screws 
you use are short enough to fit in the holes in the backplane. The screw holes are 5 mm 
(0.2 in) deep.

Mounting the Backplane on a Panel
The cFP-BP-x backplane is shipped with a panel-mount kit. Complete the 
following steps to mount the backplane on a panel:

1. Fasten the two plates of the panel-mount kit to the back of the 
cFP-BP-x using a number 2 Phillips screwdriver and the 
8-32 × 5/16 in. countersink screws shipped with the kit. These 
screws have a nylon coating to prevent them from loosening. Refer to 
Figures 2-4 and 2-5.

Caution Do not use screws longer than 5/16 in. to fasten the panel-mount plates to the 
backplane.

Figure 2-4.  Fastening the Panel-Mount Plates to the cFP-BP-4 Backplane

2. Bolt or screw the panel-mount accessory to a panel using 8-32 or 
M4 screws.

 NATIONAL 

INSTRUMENTS
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Figure 2-5.  The cFP-BP-4 Backplane with Panel-Mount Accessory

Figure 2-6.  The cFP-BP-8 Backplane with Panel-Mount Accessory

3. Connect the safety ground as explained in the Compact FieldPoint 
Safety Information section.

Caution Disconnect power before removing the backplane from the panel.

Note As shown in Figures 2-5 and 2-6, the horizontal panel-mount kit shipped with the 
backplane extends about 3/4 in. from each side of the backplane. NI also offers a vertical 
panel-mount kit that extends from the top and bottom of the backplane and is flush with 
the sides. The vertical panel-mount kit is part number 778688-01.

102 mm
(4 in.)

260.4 mm (10.25 in.)

279 mm (11.0 in.)

127 mm 
(5.0 in.)

102 mm 
(4.0 in.)

457 mm (18.0 in.)

127 mm 
(5.0 in.)

476 mm (18.7 in.)
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Mounting the Backplane in a Standard 19-in. Rack
In order to mount the cFP-BP-x backplane in an EIA standard 19-in. rack, 
you need the rack-mount kit. You can order the kit, part number 
778615-01, from NI.

Figure 2-7.  Dimensions of Compact FieldPoint Rack-Mount Kit, 
Part Number 778615-01

Complete the following steps to mount the backplane in a rack:

1. Fasten the rack-mount bracket to the back of the cFP-BP-x using the 
captive screws on the bracket. Refer to Figures 2-8 and 2-9.
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Figure 2-8.  Fastening the Rack-Mount Accessory to the cFP-BP-4 Backplane

Figure 2-9.  Fastening the Rack-Mount Accessory to the cFP-BP-8 Backplane
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2. Bolt the rack-mount accessory to a standard 19 in. rack.

3. Connect the safety ground as explained in the Compact FieldPoint 
Safety Information section.

Caution Disconnect power before removing the backplane from the rack.

Installing a DIN Rail in the Rack-Mount Accessory
If you are using a rack-mounted cFP-BP-4, you can install a short 
(approximately 8 in.) DIN rail to the right of the backplane for mounting 
power supplies, terminal blocks, or other accessories. Refer to Figure 2-10.

Figure 2-10.  Installing a Small DIN Rail in the Rack-Mount Accessory

You can install a 16 in. DIN rail in another rack-mount accessory if you 
need more DIN rail space.

1 cFP-BP-4 Backplane
2 Screw Holes

3 Short DIN Rail for Power Supply
4 #10-32 Screws, 3/8–1/2 in.

1

2

3

4
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